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Scope
This procedure serves as a general guideline for the interpretation of DNA profiles using Promega’s

PowerPlex Y23 kit to obtain Y-chromosome Short Tandem Repeat (Y-STR) profiles from extracted
DNA. This protocol is not an exhaustive list of all interpretation scenarios because the experience and
judgment of the DNA Analyst is considered when reporting DNA profiles, and two other qualified
analysts review all of the data interpretations and allele calls. If the analyst and the technical reviewers
cannot agree on allele calls or data interpretation, the Technical Leader is consulted

The non-recombining nature of the Y-chromosome means an unchanged Y-STR profile is passed from
father to son, and theoretically all the male descendants of a common male ancestor will have the same
Y-STR profile, unless there is a random mutation in the lineage which would become the inherited Y-
STR profile from that point forward.

A Y23 profile is made of up to 23 alleles across locations (loci) on the Y-chromosome: DYSS576,
DYS3891, DYS448, DYS38911, DYS19, DYS391, DYS481, DYS549, DYS533, DYS438, DYS437,
DYS570, DYS635, DYS390, DYS439, DYS392, DYS643, DYS393, DYS458, DYS385a, DYS385b,
DYS456 and YGATAH4 are amplified in a single reaction.

A portion of each amplified sample is run on a capillary electrophoresis 3500 Genetic Analyzer (3500).
Allelic ladders are run at the same time to define bins for the alleles at every locus.

GeneMapper ID-X software (GeneMapper or GMID-X) is used to analyze the data from the 3500. The
ILS is used to calculate the base pair size of all the peaks within each sample, the allelic ladders are used
to create allele bins, and the peaks in the samples are labeled based on their color and which allelic bin
they line up with. GeneMapper then removes the labels from peaks that are in a stutter position and are
below the stutter threshold level for that locus.

The DNA Analyst interprets the data, reviewing and assessing the profile’s quality, peak height ratios,
potential for mixture, dropout, etc., removing artifacts and confirming true alleles. The final allele calls
that are reliable, reproducible, and suitable for comparison are documented on a DNA Profile Summary
sheet, including how it compares to other profiles in the case.

2. Specimen

2.1  Samples amplified with the “PowerPlex Y23 Amp and Detect on 3500 protocol.

3. Instrumentation and Equipment
e PC computer
e GeneMapper ID-X software v 1.6 or greater (Life Technologies)

4. Quality Assurance:

4.1 Allele calls may be edited, and artifacts may be deleted in the GeneMapper project. All edits and
deletions must be documented in GeneMapper. This electronic record will be reviewed during Tech and
Admin Reviews.

4.2 Evidence profiles are interpreted independently of the known reference profiles:

42.1 First, interpret the data from evidence items, recording the true alleles which are copied or
exported to a DNA Profile Summary sheet.
422 Next, interpret the data from known reference samples, recording the true alleles which are copied
or exported to a DNA Profile Summary sheet.
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4.2.3 Finally, compare the known reference profiles to the evidence profiles and record conclusions in the
case file (e.g. at the bottom of the DNA Profile Summary sheet or in a case note).

424 Notations about peak height ratios, major/minor, etc. should be entered on the DNA Profile
Summary sheet so the reviewers will be able to understand the analyst’s reasoning for interpretation.

5. DNA Profile Terminology:
5.1 Allele Nomenclature

5.1.1 Typically, Y-STR profiles typically have only one allele per locus in a single-source sample.
DYS385 is the only exception since two loci (DYS385a and DYS385b) use a common, labeled
primer to produce similarly sized (and sometimes identically sized) alleles. Rarely, an individual
may have two alleles at other loci (thought to be from Y-chromosome sequence duplication).

5.1.2  Alleles are designated by the number of tandem repeats they contain. A “10” profile at a given
locus would have an allele with 10 repeats.

5.1.3 Sometimes a repeat segment lacks a full repeat unit and is called a “microvariant”. These
microvariants are designated with a numerical suffix. A “10.2” allele would have 10 repeats plus
two additional base pairs.

5.1.4 The peak height of an allele is measured in relative fluorescent units (rfu), a measure of signal
intensity. There is a direct correlation between the amount of DNA being amplified and the peak
heights within the DNA profile (i.e. peak heights are higher when more DNA is amplified).

5.1.5 Y-chromosomes are usually passed from father to son with no changes, so all patrilineal relatives
have a very high likelihood of having the exact same Y-STR profile. A “match” between a
sample and a person is also a “match” to that person’s male relatives (father, sons, paternal
uncles, and other paternal relatives, assuming there are no mutations).

5.1.6  Instead of reporting a known reference and an evidence sample as “matching”, the two profiles
are reported as being “consistent” with each other or “having the same Y-STR profiles”, and the
conclusion is reported as being “consistent with a potential donor (and his paternal relatives)”
instead of coming from a specific individual.

5.2 Analytical Threshold

5.2.1 The analytical threshold is 120 rfu. This is the minimum peak height at which DNA profiles
can be reliably and reproducibly differentiated from background noise.

5.2.2  The analytical threshold is exact and was empirically determined during validation.

5.3 Stochastic Threshold

5.3.1 The stochastic threshold is 1,000 rfu. This threshold is approximate and was determined
through validation and practical experience with the DNA profiling system.

5.3.2  Stochastic effect occurs when low levels of DNA are amplified and some alleles are copied more
than others in the first few cycles of PCR, resulting in uneven peak heights and dropout.

5.3.3  The stochastic threshold is the minimum peak height at which all the alleles in a profile should be
consistently detected. Below this threshold, one or more alleles at a locus may be completely
missing (i.e. “dropping out”).

5.3.4 The stochastic threshold is also the minimum peak height at which the general rules of peak height
ratios between the two alleles at DYS385 as well as major-minor contributors in mixtures should
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be consistently observed. Below this threshold, the two alleles at DYS385 may be imbalanced
and major/minor ratios in mixtures may be inconsistent.

Below this threshold, apparent major-minor contributors in mixtures, and apparent homozygous
and heterozygous loci, need to be interpreted with caution. If all of the alleles in a locus are
below the stochastic threshold, it may be difficult or impossible to distinguish major or minor
donors because the peak height ratios may not be reliable.

5.4 True Alleles

54.1

542

543

544

A true allele has a peak height greater than or equal to the analytical threshold, has good peak
morphology, and typically falls within an allelic bin. Artifacts in a profile need to be identified
and labeled as to what type of artifact they are

Not all peaks greater than the analytical threshold are interpreted as true alleles. Stutter peaks,

pull-up peaks, and other artifacts may exceed the analytical threshold, especially if a large amount
of DNA is amplified.

Peaks below the analytical threshold are typically not reported but can help to assess the quality
of a DNA profile, assess if a profile is a mixture or not, help differentiate true peaks from
artifacts, and determine if samples need to be re-injected or re-amplified.

Off-Scale peaks may occur when too much DNA is amplified, causing the peaks to exceed the
linear dynamic range of the Genetic Analyzer. Samples with off-scale peaks may exhibit raised
baseline, pull-up, and/or high stutter peaks. An off-scale peak may appear to have double peaks
or a flat top. Samples with off-scale data may be re-amplified using less DNA.

5.5 Off-Ladder Alleles

5.5.1

552

553

554

5.5.5

Off-ladder (OL) alleles are reproducible peaks that do not fall within an allele bin in the ladder.
An OL allele falls above or below the allelic ladder range (due to the number of repeat units
exceeding the range in that locus of the ladder), or it falls between the bins of the allelic ladder
(due to a repeat unit being smaller than usual).

The size of an OL allele can be interpolated by adding or subtracting the appropriate base pairs
from the closest allele, or it can be extrapolated by adding or subtracting the appropriate repeat
sizes from the closest allele.

Forensic Unknown samples with OL alleles must be amplified twice (to document
reproducibility) before reporting a match at that locus or entering that locus into a database.
Otherwise, the locus must be interpreted as inconclusive. In order to declare a match, the same
rare allele must be observed in both the questioned sample and the known sample.

Known Reference samples with OL alleles must be amplified twice if they are going to be
reported as matching an evidence item. If a Known Reference sample is excluded as a potential
donor to the evidence, the OL allele does NOT need to be verified.

Other reports of microvariant alleles may be found on the STR Fact Sheet listed on the National
Institute of Standards and Technology (NIST) Short Tandem Repeat DNA Internet Database web
site (https://strbase.nist.gov//var_tab.htm).
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Highly Degraded Samples.

5.6.1  Typically, the largest loci are the first to demonstrate decreased peak heights or fail to amplify
(drop out) as samples become more degraded.

5.6.2  Highly degraded samples must be interpreted with caution: stutter peaks can be higher;
degradation products can cause spurious peaks, and there is a higher propensity for unbalanced
heterozygous alleles and dropout.

Inhibited Samples.

5.7.1 Inhibited samples are extracts that contain some impurity that halts the polymerase enzyme
activity or otherwise impacts the efficiency of the PCR reaction.

5.7.2 Inhibited samples may show unusual stutter peaks as well as unusual balance and dropout patterns
within and across loci.

5.7.3 Inhibited samples may mimic the appearance of degraded samples, although the pattern of loci
dropping out can be different (i.e. does not correlate to the size of the loci).

Stutter peaks

5.8.1 During PCR, the enzyme sometimes adds fewer (and sometimes extra) repeat units to a fraction

of the copies it is making due to “enzyme slipping”. These peaks typically appear one repeat unit
to the left (or right) of a true allele at a fraction of the true allele’s height.

5.8.2 GeneMapper will “filter” stutter peaks if they fall below the stutter peak threshold that is defined
at that locus. The height of a peak in the stutter position is calculated as a percent of the true
allele, and the peak’s label is removed if the stutter peak is < the stutter threshold.

5.8.3 Typically, stutter peaks are one repeat unit smaller than the allele peak (e.g. n-4 for a 4-base pair
repeat, or n-3 for a 3-base pair repeat), and will appear to the left of the true allele.

5.8.4 Less commonly, stutter peaks one repeat unit larger than the allele peak (e.g. n+4 for a 4-base pair
repeat, or n+3 for a 3-base pair repeat) can appear, especially when too much DNA is amplified.
5.8.5 Additional DNA-dependent artifacts (caused by PCR amplification):
e DYS19 may display n-2 and n+2 peaks.
e DYS448 may display n-9 to n-15 peaks due to amplification of excessive DNA template
(artifacts are variably sized and may be from double-stranded DNA in the injection).
5.8.6  Additional DNA-independent artifacts (caused by storing plates at 4 °C):
e Low-level Blue peaks between 68-71 base pairs in size.
e Low-level Green peaks between 60-62 base pairs in size.

5.8.7 If a known reference sample (which is presumably a single source template) displays stutter peaks
greater than the stutter threshold (usually due to excessive DNA), it does not require reinjection
(but should be noted on the DNA Profile Summary sheet).

N-1 peaks
5.9.1 The Y23 kit is optimized to add an extra adenosine nucleotide (““A”) to the 3-prime end of the

PCR product. When the reaction fails to add this A-nucleotide to a significant number of PCR
copies, a peak one base pair shorter than the true allele (n-1) may be observed.
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5.9.2 N-1 peaks usually occur because the amount of input DNA is too much. The sample may be re-
amplified with less DNA.

Pull-up Peaks

5.10.1 Iftoo much signal is detected by the instrument, an overlap in the emission spectra of the dyes
causes a peak to appear in other colors (spectra), producing pull-up peaks the same size but in
different colors.

5.10.2 Pull-up peaks should have approximately the same fragment size as the true allele peak and can
be verified by comparing the scan numbers or base pair sizes of the peaks. The sample may be re-
amplified with less DNA.

Spurious Peaks/Anomalies

5.11.1 Spurious peaks are peaks/signal that cannot be reproduced (such as an electronic spike). It occurs
randomly during a run, and usually does not originate from the amplification reaction.

5.11.2 If the anomaly is in more than one color (i.e. a spike) or falls outside of the allele calling range,
interpretation can be made from the one injection. If the anomaly is present in only one color and
falls within the allele calling range, the sample should be re-injected to show it’s not reproducible.

Inhibited Samples

5.12.1 Inhibited samples contain impurities that affect the amplification step by inhibiting the
polymerase enzyme activity or affecting the primer annealing.

5.12.2 Inhibited samples may show differences in stutter peaks, off-ladder alleles, and allele or locus
drop out not related to the base pair size of the loci.

Internal Lane Size standard

5.13.1 The ILS is a set of DNA fragments (60, 65, 80, 100, 120, 140, 160, 180, 200, 225, 250, 275, 300,
325, 350, 375, 400, 425, 450, 475, and 500 bp) labeled with orange (WEN).

5.13.2 GeneMapper uses these known bp sizes to determine the bp size of the other peaks in a sample.

6. STR Analysis
6.1 Importing and Analyzing Data:
6.1.1 Open the GeneMapper software. Select a username and enter the password.

e FEach DNA Analyst has their own password-protected username (the software will make them
create a new password at the first log in). Only the Administrator (gmidx) can add, delete, or
modify users in Admin - Security Manager.

6.1.2  Choose Edit > Add Samples to Project (or use control-K or click "1-‘:1), double-click on “This PC”
and navigate to H:\Crimelab\DNA\3500 runs.

6.1.3 Choose a user’s data folder, click on the relevant run folder, click “Add to List”, and then “Add”
or “Add & Analyze”.

6.1.4 If not already set, specify the Sample Type (Sample, Allelic Ladder, Positive Control, Negative

Control).

e The Sample Type can be set in Data Collection on the 3500 Genetic Analyzer.

6.1.5 If not already set, specify the Analysis Method (Y23 3500 120-1000), Panel

(PowerPlexY23 IDX v2.0), and Size Standard (WEN _ILS 500 IDX).
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e The Analysis Method, Panel, and Size Standard can be set to default values (File = Project
Options > Add Samples) and then changed before analyzing if different than the default (e.g.
when analyzing Y23).

6.1.6  Choose Analysis = Analyze (or use control-R or click #).

e (Can also highlight specific samples and choose Analysis = Analyze Selected Samples (to
force reanalysis of specific samples) or choose Analysis = Analyze All (to force reanalysis of
all samples in the project).

6.1.7  When analysis of the project is complete, the project displays Quality Metrics in the righthand
columns. For example, SFNF (sample file not found), SOS (Sample Off Scale), SQ (Sizing
Quality), SSPK (Sample Spike), MIX (Mixture), OMR (Outside Marker Range), and CGQ
(Composite Genotype Quality).

6.2 Viewing Electropherograms:

6.2.1 Click or control-click the sample(s) of interest (or control-A to select all of the samples), and then
View > Display Plots (or use control-L or click [iill) to view the electropherograms.

e The electropherogram view can also be changed by choosing from the drop-down list next to
Plot Setting (e.g. check WEN-ILS, Fusion, Y23).

e The display area can be zoomed in clicking-and-dragging in the base pair size area just above
the electropherogram. To zoom out, double-click in locus name or the base pair size area.

e Choosing the number of panes, the blue/green/yellow/red/orange dyes, whether tables are
displayed or not, displaying the ladder at the top of the window, etc. are all controlled with
buttons across the top of the electropherogram window.

e To save a view, go to Tools = Plot Settings (or use control-T or click @) while viewing the
electropherograms and choose Save.

6.2.2  The Controls should be inspected:

e Ladders should be inspected for proper allele bins.

e Reagent Blanks and Negative Controls should be examined for the presence of any
interpretable profile.

e Positive Controls should be examined for the expected DNA profile (see Expected Control
Values section). The 2800M Control DNA is extracted from a cell line and can have poor
balance within loci as well as between loci.

e The migration of the ILS should be checked for appropriate labeling of peaks and/or peak
morphology due to migration issues.

6.2.3 The Samples should be inspected:

e Note the number of alleles, peak heights and ratios, elevated stutter and other artifacts, peak
morphology, evidence of degradation or inhibition, etc.

e The migration of the ILS should be checked for appropriate labeling of peaks and/or peak
morphology due to migration issues.

6.3 Interpreting and Documenting DNA Profiles:

6.3.1 DNA profiles can be edited in GeneMapper (e.g. deleting artifacts and high stutter). The saved
project will be reviewed at Technical and Administrative reviews.
6.3.2 Notation should be entered when deleting peaks (e.g. “pull up” or “spike”) so the reviewers will
be able to understand the analyst’s reason for deleting a peak.
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Notations about peak height ratios, major/minor, etc. should be entered on the DNA Profile
Summary sheet so the reviewers will be able to understand the analyst’s reasoning for
interpretation.

6.4 Documenting DNA Profiles:

6.4.1 DNA profiles can be edited in GeneMapper (e.g. deleting artifacts and high stutter). The saved
project will be reviewed at Technical and Administrative reviews.

6.4.2 Notations about deleting peaks (e.g. “pull up” or “spike”) should be entered into the GMID-X
project so the reviewers will be able to understand the analyst’s reason for deleting a peak.

6.4.3 Notations about peak height ratios, major/minor, etc. should be entered on the DNA Profile
Summary sheet so the reviewers will be able to understand the analyst’s reasoning for
interpretation.

6.4.4 To avoid transcription errors, the interpreted casework DNA profiles should be copied from
GMID-X and recorded on DNA Profile Summary sheets.

6.4.5 After analyzing, editing, and saving the project, click on the “Genotypes” Tab.

6.4.6  Highlight the rows and columns to be copied (or type Control-A to highlight everything).

6.4.7 Type Control-Shift-C to copy the cells and the column headers (or Control-C to copy the cells
without any headers).

6.4.8 Launch Excel and type Control-V to paste the values into the spreadsheet.

6.4.9 Each row will have the sample name, run name, marker, and the alleles and peak heights for that
locus.

6.4.10 It is easier to format the data in Excel (e.g. deleting columns that have no alleles, extraneous
columns such as the Run Name, deleting extraneous rows of ladders and blanks, and bolding
allele calls and headers).

6.4.11 Click any cell containing data on in the spreadsheet and type CONTROL + A and then
CONTROL + C. This will highlight all the cells that have data in them and then copy them.

6.4.12 Go to the “H:\Crimelab\DNA\DOCS\FORMS” folder, open the Word template for Y23, and type
CONTROL + V to paste the data copied from Excel into the Word document.

6.4.13 Go back to the top of the first page in the Word doc (Control-Home) and click in the first row of
the table and click on the REPEAT HEADER ROWS button “J (copies the first row to top of
every page).

6.4.14 Type Control + A to select the entire table and then click the ALL BORDERS button H to add
lines around all of the cells in the table.

6.4.15 Hover the mouse over the vertical lines between columns and double-click on the vertical line or
drag the vertical line to the right (this makes the column wider, so all the cells have enough room
for the data).

6.4.16 Click in a cell in the column furthest to the right and then click the “insert column to the right”
button F%.

6.4.17 Hover the mouse over the far-right border of the table and drag the vertical line to the right (this
makes the column wider so there will be room to write notes about each locus).
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6.4.18 Choose “File — Save As” or click the SAVE AS button [#! to save the DNA Profile Summary
pages. Print all of the pages and insert them into their respective case folder.

6.4.19 The Pos, Neg, and RB controls can be copied or re-printed and placed in all of the relevant case
folders, or a note can be written in each case file stating the controls are appropriate.

6.4.20 In a DNA Profile Summary sheet, balanced alleles (e.g. >60%) should be separated by a comma,
alleles that appear to be minor (e.g. < 30%) should be separated by parentheses, and alleles that
are between balanced and minor (e.g. between 30% and 60%) should be separated by less-than or
greater-than signs.

Reopening or Reviewing Projects:

6.5.1 Log into the GeneMapper software.

6.5.2 Choose File > Open Project (or use control-O or click %). Projects previously saved in GMID-
X will appear in the GMID-X Database (with newest projects at the top of the list).

6.5.3 Holding Shift and clicking on a column header will sort the list by that column, or click on a
column header, type part of the name being searched, and click on Search.

6.5.4  Scroll down the list of projects and double-click on a project to open it.

6.5.5 Click or control-click the sample(s) of interest (or control-A to select all of the samples), and then
View = Display Plots (or use control-L or click M) to view the electropherograms.

6.5.6 Choose Plots > Table > Label Edit Viewer to see a list of edits made to allele labels at the bottom
of the window. Clicking on each allele in the table in the lower part of the window brings up the
corresponding plot in the upper window.

Printing DNA Electropherograms (optional):

6.6.1 Electropherograms will print as displayed on the screen. Additional views can be created and
saved specifically for printing electropherograms.

6.6.2 Zoom in or out to the region of interest, click Print Preview to verify the number of panes that
will fit on each page, and then click Print.

Recognition of Single-Source Profiles

A single-source DNA profile appears to originate from only one individual based on an interpretation of

all the loci within a profile.

The number of alleles at each locus is the most obvious indicator of the minimum number of
contributors. A single-source profile should have no more than one allele at each locus. DYS385 is the
only exception since two loci (DYS385a and DY S385b) are detected in the same area and can appear as
two (non-overlapping) alleles. If only one allele is present at DY S385, that allele should be above the
stochastic threshold to be confident a potential second allele hasn’t dropped out.

Interpretation of Single-Source Profiles
Examining the electropherograms and the DNA Profile Summary sheet, apply the rules of expected peak
height ratios and stochastic thresholds.

All of the alleles meeting the criteria for a ‘true’ allele should be interpreted and recorded on the DNA
Profile Summary sheet.
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A “complete profile” contains reportable results for all 22 loci, and no dropout has occurred (i.e. all of the
loci are interpretable, reportable, and suitable for comparison).

A “partial profile” has reportable results for less than 22 loci (possibly due to degradation, inhibition,
and/or low template amounts). Only the loci that are suitable for comparison will be reported; all other
loci should be considered “inconclusive”.

A “composite profile” is a profile generated by combining multiple injections and/or multiple
amplifications of the same DNA extract. Separate extracts from different locations on an evidentiary
item cannot be combined into a composite profile unless there is a reasonable expectation of the samples
originating from a common source (e.g. duplicate vaginal swabs, multiple samples of the same
bone/muscle/tissue, contiguous cuttings from a small stain, or a known reference sample).

Match Criteria for INCLUSION

Inclusions can be made by comparing a questioned profile directly to an individual (i.e. the victim or
suspect) or by comparing a questioned profile to direct paternal relatives of an individual (i.e. the
individual’s father, brother, son, etc.) since the paternal relatives should have the same Y-STR profile.

It is impossible to identify an evidence item’s Y-STR profile as originating from a specific individual
since their paternal relatives cannot be excluded as potential sources based on Y-STR profiles alone (no
matter how discriminating a Y-STR profile might be).

If a single source ‘match’ between evidence and a known reference is concluded, statistical probabilities
that represent the strength of the inclusion MUST be reported. For single-source profiles, the profile
frequency, the profile probability, and the match probability statistics are used (see Genetic Analysis
method).

DIRECT COMPARISON INCLUSION = when a direct comparison between a questioned sample and a
known reference sample produces no differences at the overlapping loci. If only one allele is present at
DYS385, that allele should be above the stochastic threshold to be confident a potential second allele
hasn’t dropped out.

PATERNAL LINEAGE INCLUSION = when a comparison between two samples produces differences
at one locus or less between the two profiles. This can be a comparison between a questioned sample
and a paternal relative of the suspect or victim, or it can be a comparison between known references from
two individuals to test if the two individuals are paternally related.

Results for a direct or paternal lineage inclusion may be reported as:
“The Y-STR profile obtained from [Item A] is consistent with the Y-STR profile obtained from the known
reference of [Item B].” (followed by statistical probabilities).

or
“The partial Y-STR profile obtained from [Item A] is consistent with the Y-STR profile obtained from the
known reference of [Item B] at the overlapping loci.” (followed by statistical probabilities).
The statistical probability for an inclusion may be reported as:
“This Y-STR profile was observed in X of N United States Caucasians/Asians/Hispanics/African-
Americans/Native-Americans in the YHRD.org database, with a profile probability of 1 in Y individuals (95
% upper confidence limit). This profile has an overall match probability of 1 in Z for all U.S.
subpopulations.”

or
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“This Y-STR profile was not observed in any United States subpopulations in the YHRD.org database, with
a profile probability of 1 in Y individuals (95 % upper confidence limit). This profile has an overall match
probability of 1 in Z for all U.S. subpopulations.”

9.8  Conclusions for an inclusion may be reported as:

“[Item B] and his paternal relatives are included as potential donors for the Y-STR profile obtained from
[Item A].”

10. Criteria for EXCLUSION

10.1 Exclusions can be determined by direct comparison to an individual or by comparing to a direct paternal
relative (i.e. the individual’s father, brother, son, etc.).

10.2 Direct Comparison Exclusion: when a direct comparison between two samples (e.g. a questioned sample
and a known reference sample) produces a single difference at single-copy loci. If only one allele is
present at DY S385, that allele should be above the stochastic threshold to be confident a potential second
allele hasn’t dropped out.

10.3 Paternal Comparison Exclusion: when a comparison between two samples believed to be from the same
paternal lineage (e.g. a comparison between an alleged father and son or grandson) produces differences
at two or more loci between the two profiles. If only one allele is present at DY S385, that allele should
be above the stochastic threshold to be confident a potential second allele hasn’t dropped out.

10.4 Results for a direct or paternal lineage exclusion may be reported as:

“A Y-STR profile was obtained from [Item A]. A different Y-STR profile was obtained from [Item B].”

10.5 The following conclusion can be made for an exclusion:

“|Item B] and his paternal relatives are excluded as potential donors for the Y-STR profile obtained from
[Item A].”

11. Recognition of Mixtures

11.1 The detection of two or more alleles at two or more single-copy loci generally indicates the presence of a
mixture (i.e. more than one male contributor in the DNA extract). Since DYS385 is a multi-copy locus,
three or more alleles are needed to indicate a mixture at that locus.

11.2 Stutter greater than the threshold may indicate a mixture (potentially a minor donor’s allele in the stutter
position). Additional information provided by other loci may be necessary to confirm there is a mixture.

11.3 Allele peaks below the analytical threshold can help in the interpretation of a mixed DNA sample, but
typically are not reported.

12. Major - Minor Mixtures

12.1 If the peak heights in one set of alleles in a mixture are at least 3 times greater than the peak heights of
the other contributor’s peaks (locus by locus), a mixture could be considered a major-minor mixture.

12.2 If it is possible to reliably segregate the major donor’s alleles from the minor donor’s alleles, the alleles
from a single major donor can be used for comparison purposes (inclusions and exclusions) in the same
fashion as a single-source profile.

12.3 If there is a single minor donor and the minor peaks are above the stochastic threshold, it is possible the
alleles from the minor donor could be used for comparison purposes (inclusions and exclusions) in the
same fashion as a single-source profile.
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13. Deduced Profiles from Mixtures on Intimate Body Swabs

13.1 In mixed samples of two or more male contributors where one person’s DNA can be reasonably assumed
to be present (e.g. on an intimate body swab), the presumed donor’s alleles may be subtracted from the
mixture to reveal the obligate alleles of the other donor(s) to the mixture.

13.2 If there is only one “deduced donor”, both inclusions and exclusions can be interpreted in the same
fashion as a single-source profile.

13.3 If there is still a mixture of “deduced donors™, only exclusions can be interpreted since statistical
probabilities for Y-STR mixtures are not validated at this time.

14. Mixtures that Cannot be Deconvoluted

14.1 In a mixed profile of two or more male contributors which cannot be resolved as a major/minor mixture
and which does not involve an intimate body swab, only exclusions can be interpreted since statistical
probabilities for Y-STR mixtures are not validated at this time.

14.2 The alleles at DY S385 used for exclusion should be above the stochastic threshold in order to be
confident alleles have not dropped out. False exclusions from allelic dropout could occur if a mismatch
is interpreted but the alleles are actually missing due to dropout.

15. Criteria for UNINTERPRETABLE Mixtures

15.1 A mixture of two or more males should be reported as uninterpretable (due to complexity) unless the
mixture has a clear major and/or a clear minor donor.

15.2 A low-level Y-STR profile where a large portion of the peak heights are below the analytical threshold
may be reported as uninterpretable (due to limited genetic info).

15.3 Results for uninterpretable profiles may be reported as:

“Due to the limited genetic information of the Y-STR profile obtained from [Item A], the results are not
suitable for comparison to known standards”.

or
“Due to the complexity/ limited genetic information of the Y-STR mixture obtained from [Item A], the
results are not suitable for comparison to known standards”.

15.4 The following conclusion can be made for uninterpretable results:

“No conclusions can be drawn from the results obtained from [Item A].”
16. Expected Control Values
16.1 Positive PCR Control:
Blue Loci | 2800M | Green Loci | 2800M | Yellow Loci | 2800M | Red Loci | 2800M
DYS576 | 18 DYS391 | 10 DYS570 | 17 DYS393 | 13
DYS3891 | 14 DYS481 | 22 DYS635 | 21 DYS458 | 17
DYS448 | 19 DYS549 | 13 DYS390 | 24 DYS385a/b | 13,16
DYS38911 | 31 DYS533 | 12 DYS439 | 12 DYS456 | 17
DYS19 | 14 DYS438 | 9 DYS392 | 13 Y-GATAH4 | 11
DYS437 | 14 DYS643 | 10
16.1.1 Ideally, all of the alleles will be detected, but the positive control is considered appropriate even if
some alleles dropout or fall below the detection threshold, as long as the interpretable loci are
consistent with the expected profile.
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16.3

17.
17.1
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16.1.2 If the positive control does not work or does not type correctly, repeat the injection, or try re-
injecting a fresh aliquot of the positive control.

16.1.3 If the positive control does not work or types incorrectly after trying to re-run the control
repeatedly, the test results for that set of amplifications will be rendered inconclusive and will
need to be re-amplified.

16.1.4 Possible explanations for an incorrect or failed positive control include faulty control DNA,
contamination, failure to add control DNA, or instrument failure.

Negative PCR Control:
16.2.1 There should be no interpretable DNA profile in the negative control.

16.2.2 If the negative control produces an interpretable DNA profile, repeat the injection, or try re-
injecting a fresh aliquot of the negative control.

16.2.3 If the negative control gives an interpretable DNA profile after trying to re-run the control
repeatedly, the test results for that set of amplifications will be rendered inconclusive and will
need to be re-amplified.

Reagent Blank Control:
16.3.1 There should be no interpretable DNA profile in the reagent blank.

16.3.2 If the reagent blank produces an interpretable DNA profile, repeat the injection, or try re-injecting
a fresh aliquot of the reagent blank. If the reagent blank gives an interpretable profile after trying
to re-run the control repeatedly, the reagent blank should be re-amplified (sample permitting).

16.3.3 If the interpretable DNA profile is not reproduced in the reagent blank, the results can be
reported; if any interpretable profile is detected repeatedly, then the samples extracted with that
particular reagent blank will be rendered inconclusive if the source of contamination cannot be
identified or the reagent blank matches the reported profile in the questioned samples. An
exception would be if a very high amount of DNA is in the sample and is likely to have
contaminated the reagent blank, rather than a contaminated reagent (and reagent blank) is
producing a profile in the sample.

16.3.4 If the reagent blank repeatedly produces an interpretable DNA profile and sample size permits,
DNA can be re-extracted from the affected test samples with a new reagent blank. The lots of
reagents used should be considered potentially contaminated and QC tested or discarded as soon
as possible.

Statistical Analysis

Follow the “Genetic Analysis” method to calculate the statistical significance of any matches/inclusions.
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18. PowerPlex Y23 loci:

Stutter # of .
Dye Locus Threshold | Repeats Repeat Sequence Ladder Bins
14.7 % N—4
DYS576 4.8% N+4 AAAG 10 —24
DYS3891 8.1 % N—4 [TCTG][TCTA] Complex 9-17
BI DYS448 4.0 % N-6 AGAGAT 14-24
(FE§ DYS38911 15.2 % N—4 [TCTG][TCTA] Complex 24 -36
10.7 % N—4
10.2% N-2
DYS19 3.8% NT2 TAGA 9-19
6.7% N-+4
12.4 % N—4
DYS391 2.2% NT4 TCTA 5-16
29.8 % N-3
DYS481 5.5 NT3 CTT 16 —33
Green 11.4 % N—4
(JOE) DYS549 4.8% NT4 GATA 6-18
10.7 % N—4
DYS533 3.1% NT4 ATCT 7-18
DYS438 5.0 % N-5§ TTTTC 6-—16
DYS437 8.4 % N—4 TCTA 10-18.2
15.9 % N—4
DYS570 3.6% NT4 TTTC 9-26
11.5 % N—4
DYS635 2.4% N+ 4 TSTA compound 15-29
o,
Yellow | DYS390 S L b N-4 (TCTA)TCTG) 17-29
2.0% N+4
(TMR) 10.7 % N—4
. (1)
DYS439 2.7% Nid AGAT 5-18
171 % N-3
DYS392 10.5% NT3 TAT 4-20
DYS643 3.9 % N-5 CTTTT 5-18
15.1 % N—4
DYS393 2.7% Ntd AGAT 7-18
14.7 % N—4
DYS458 2.2% Ntd GAAA 10-24
Red 14.9 % N—4
(CXR) DYS385a/b 5.6% Ntd GAAA 7-28
15.1 % N—4
DYS456 3.8% Ntd AGAT 11-23
11.1 % N—4
YGATAH4 2.6% Ntd TAGA 8§18
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19. Artifacts Other Than Stutter:
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Locus or Dye Label

DNA-Dependent Artifacts

DNA-Independent Artifacts

Fluorescein (blue)

61-65 bases 3
58-63 bases 3
136—144 bases ¢

163 bases ?
JOE (green) ;2; EZZ:Z z 136-144 bases *
272 bases ?
159 bases ?
TMR (yellow) 428 bases ?
441 bases ?
CXR (red) 201 bases 2
DY S448 n—9ton-151
DYS19 n—2; nt2

1 These variably sized peaks are noticeable with high levels of DNA (from double-stranded DNA

which migrates faster than single-stranded DNA).

2 Artifact is observed more often with samples that contain relatively high levels of female DNA.

3 These artifacts increase when amplified product is stored at 4 °C (sometimes as fast as overnight,
but usually after a few days).

4 Artifact may appear as a dye blob or a peak in sample reaction and negative control reaction.
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